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Product Description 

The Smith MeterTM SyberMate is a software tool that 
simplifies set-up and maintenance of the Smith Me-
terTM SyberTrolTM. It is designed to operate on a PC 
equipped with Windows 3.0 or above. 

Application 

Applications include initial profiling of new Syber-
Trols, maintenance of SyberTrol parameters, viewing 
of SyberTrol run time data, setting up configurable 
reports and displays and aiding the development of 
supervisory systems. 

The SyberMate consists of three basic modes of op-
eration:  Offline Mode, Read-Only Mode and an On-
line Mode. 

Offline Mode 
In the Offline Mode of Operation the SyberMate can 
be used to completely set up a data file or edit a file 
in the computers editor.  This file can then be saved 
for future use or by changing to Live Mode it can be 
downloaded to the SyberTrol. 

Read Only Mode 
The Read Only Mode is used in the SyberMate for 
those times when it is being used only to read infor-
mation from the SyberTrol.  The Read Only Mode of 
operation can be entered by two separate methods.  
The first is if the operator does not enter the correct 
access code for the SyberTrol a message will pop up 
“You can only read this SyberTrol data”.  If the opera-
tor clicks ‘OK’ or presses ‘ENTER’ on the keyboard of 
the computer the SyberMate will automatically go into 
the Read Only Mode and no data will be allowed to 
change.  The second method of entering the Read 
Only Mode is when changes are made to the pa-
rameters using the Save Changes (F2 Key).  A de-
vice updated popup window will appear asking the 
question “Continue Live Editing? (Yes for Online 

 

Mode, No for Read_Only)”, the operator can choose 
to either stay in Online Mode or go to the Read Only 
Mode.  If the choice is to go to the Read Only Mode 
of operation, data will be read only and no changes 
will be allowed to parameters. 

 
Online Mode 
The Online Mode of operation requires that the Sy-
berTrol and the SyberMate’s communications port 
are set up with the same baud rate, parity, protocol 
and address of the SyberTrol.  Also a definition or file 
has to be created for the SyberTrol that is being 
communicated with.  The file is set up by selecting 
File and then selecting New SyberTrol. 

Once the setups have been completed, communica-
tions can be established by selecting File and then 
selecting Login-Relogin which will pop up the dialog 
box that requests the desired security level access 
code.  When the access code is entered and ‘EN-
TER’ is pressed the SyberMate will check the access 
code and if it is correct will go on-line with the Syber-
Trol. 

When in the Online Mode the SyberMate can be 
used to configure the SyberTrol, inquire alarm, batch, 
run and prove data, read information from the Syber-
Trol or dump directories or entire files to the Syber-
Trol.  Information is sent to the SyberTrol by either 
using the “Dump” icons or going to file and then to 
Save Changes, the SyberMate will save the changes 
in your file on the PC as well as update the SyberTrol 
with the changes. 

 
System Requirements 

The SyberMate will operate on an IBM-PC compati-
ble (386 or better) computer operating in a Windows 
environment (3.0 or later) with at least 2M of memory 
and one 3-1/2” floppy disk drive.  The hard drive 
should have at least 1M of free disk space. 
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To install the SyberMate Computer Program: 
 
1. Insert the SyberMate diskette into the 3-1/2” 

floppy drive. 

2. From the Program Manager screen click on File 
or hold down the ALT key and Type “F” to select 
File. 

 
3. Type “R” or click on Run to select Run. 

 

 
4. On the command line type A:\setup and press 

‘ENTER’ or click on OK.  If not using the A drive 
replace with the letter of the drive with the 
SyberMate Install disk. 

 
5. The next screen will have the SyberMate name 

and the Smith Meter logo in the upper left hand 
corner of the screen and the following box in the 
center. 

 

Smith Meter, Inc. - An FMC Corp.

SyberMate for Windows

Re-Install

Remove

Cancel
Source Drive Destination Drive: Install to Directory

Space Required     >  2  KB

Space Available     > 94298 KB

SYBRMATE

Windows for Workgroups

A: C:

A:
B:
C:

A:
B:
C:

↑ ↑

↓ ↓

 
 
 
The Source Drive is the drive that is being used to 
load the SyberMate.  If installing from the diskette the 
source drive would be A: or B:.  If the files were cop-
ied to a hard drive the selections will allow the choice 
of the hard drive designations. 

The Destination Drive is the drive that the program is 
to reside on and run from. 

Install to Directory: The directory on the computer 
that the program will be installed under.  The default 
is SYBRMATE, if a different directory is required the 
default can be changed. Using either the mouse or 
‘TAB’ key move the cursor to this location and re-
name the directory. 

Space Required: The number of free bytes required 
to load the program. 

Space Available: The number of free bytes available 
on the drive that has been selected for loading the 
program. 

 

6. The buttons on the right hand side of window are 
used to install the program, remove the program 
from the computer or cancel the installation of the 
program. 

 
7. Using either the mouse or the ‘TAB’ key and 

pressing ‘ENTER’ with the INSTALL highlighted 
will start the process of loading the program onto 
the hard drive if the destination is one of the disk 
drives on the Computer.  While going through the 
install process a screen will show the percentage 
of the files and program that has been loaded.  
When the loading process has been completed 
the Installation Completed screen will appear. 
Pressing ‘OK’ will acknowledge the End of the 
Installation. 

 
8. The installation process is now complete and a 

new program group has been added to the Pro-
gram Manager Window. 

 
9. To check the files that should be installed to run 

the SyberMate program double click on the 
“SyberMate Info” icon on the SyberMate for 
SyberTrol window.  The following information will 
appear on the screen: 
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SyberMateTM 
 

 for SyberTrol
TM

 
 
SyberMate is a Windows-based software application for programming the SyberTrol flow computer from FMC 
Technologies Measurement Solutions, Inc. - a worldwide leader in measurement products for the custody transfer 
of petroleum and related products. 

NEW IN REVISION 2: 
A translation tool has been added to handle translation of any literal string in the SyberTrol, for customization of 
specific strings or a complete language change. 

An equation editor has been added that allows the user to define a customized subprogram that can be down-
loaded to the SyberTrol, with read access to all SyberTrol database variables and the ability to execute com-
mands such as start/end batch, print report, write to user variables, etc. 

Also, added support for the new Skid configuration area, the ability to read and write from the new user data and 
user timer data areas, and improved the Report Editor to be able to create batch reports. 

NEW IN REVISION 1: 
Support for User Configurable Reports and User Configurable Displays. 
 
Installed files should include: 
 
  SMWIN.EXE - the SyberTrol executable file. 
 
  SYBRMATE.DAT - data for the windows, help, and dialog boxes in the application. 
 
  SMIFONT.FON - font file used by Report/Display Editors and Translator. 
 
  SYSTEM.SDF 
  METER.SDF 
  PRODUCT.SDF 
  DIO.SDF 
  ANIO.SDF 
  PIO.SDF 
  COMM.SDF 
  PROVER.SDF 
  SECURITY.SDF 
  ALARMMTR.SDF 
  ALARMSYS.SDF 
  MBATCH.SDF 
  MRUN.SDF 
  DIORUN.SDF 
  ANIORUN.SDF 
  PIORUN.SDF 
  PROVE.SDF 
  QUICK.SDF 
  TRIPS.SDF 
  REPORT.SDF 
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 DISPLAY.SDF 
 SYSCTRL.SDF  
 MTRCTRL.SDF 
 DIOCTRL.SDF 
 ANIOCTRL.SDF 
 SKID.SDF 
 USER.SDF 
 TIMER.SDF - SyberTrol data files; these files inform SyberMate where to look in the SyberTrol for specific 

information. 
 

*.SY - a SyberTrol configuration file.  Several examples are shipped with the program.  These include 
DEFAULT.SY, DEMO1.SY and DEMO2.SY. 

 
SY.LST  - list of SyberTrol device configurations stored on disk.  Is updated when you add new or delete 

old SyberTrol definitions. 
 
SM.CFG - SyberMate configuration file.  Stores information such as current options and last used 

SyberTrol configuration. 
 
  SYBRMATE.WRI - this file. 
 
 
Contact your Smith MeterTM distributor if any files are missing or you have any other problems with the  
SyberMate installation. 
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Establishing Communications 

In order for communications to function the SyberTrol 
and the SyberMate setups must be compatible and 
the communications cable correctly wired.  Several 
SyberTrol parameters must be set properly to enable 
communications, then the SyberMate setup must be 
configured to match the SyberTrol parameters. 

Communication Cable Wiring 

Select an available communications port; Com1, 
Com2 or Com3.  Only three wires are necessary for 
EIA-232 serial communications.  They must be con-
nected as follows: 

Computer Port  
(9 Pin Connector) 

SyberTrol 
(15 Pin Connector) 
Comm Port #1 
(9 Pin Connector) 
Comm Port #2 and 3 

1 - Shield 1 - No Connection 

2 - Receive 2 - Transmit 

3 - Transmit 3 - Receive 

5 - Ground 7 - Ground 

 

Computer Port 
(25 Pin Connector) 

SyberTrol 
(15 Pin Connector) 
Comm Port #1 
(9 Pin Connector) 
Comm Port #2 and 3 

1 - Shield 1 - No Connection 

2 - Transmit 2 - Transmit 

3 - Receive 3 - Receive 

5 - Ground 7 - Ground 

 

Configuring SyberTrol Communications 

To configure the SyberTrol for communications, use 
the keypad to select the following menus/program 
parameters: 

1. From the “Main Menu” select 8. Program Mode 
Menu and press ‘ENTER’. 

2. Enter the passcode for programming, default 
from the factory is “0”. 

3. From the “Program Mode Menu” select 6. Com-
munications Menu and press ‘ENTER’. 

4. From the “Communications Menu” select the 
communications port that is being set up for the 
SyberMate. (Comm Port #1, 2 or 3) and press 
‘ENTER’. 

5. From the “Communications Port Menu” select 1. 
Comm Protocol and press ‘ENTER’. 

6. From the Comm Protocol parameter select 6. 
Smith ASCII LRC, 7. Smith ASCII CR or 8. Smith 
Binary as the protocol for communicating with the 
SyberMate and press ‘ENTER’. 

7. From the “Communications Port Menu” select 2. 
Baud Rate and press ‘ENTER’. 

8. From the Baud Rate parameter select the re-
quired baud rate for the communications and 
press ‘ENTER’. 

9. From the “Communications Port Menu” select 3. 
Data Format and press ‘ENTER’. 

10. From the Data Format parameter select the re-
quired number of bits per character and the type 
of parity and press ‘ENTER’. 

The communications port in the SyberTrol is now set 
up for communicating with the computer that is run-
ning the SyberMate program.  Ensure that your Sy-
berMate program is set up for the same protocol, 
baud rate and data format that the SyberTrol has 
been programmed to. 
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Configuring SyberMate Communications 

After the SyberTrol has been set up for communications and the cable has been connected to the serial port on 
the computer, the SyberMate can be configured for communications. 

 
1.  Locate the program group SyberMate for SyberTrol and double click on the FMC Icon. 
  
  
  
  

  
  
 

Figure 1 
 
 

2.  Using the mouse click on the “Offline Mode” button on the SyberMate Screen. 
  
  
  
  

  

  
  
Figure 2 
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3.  Under “File” select Comm Setup.  The Communication setup screen will be displayed.  On this screen the 
Comm Port, the baud rate, the data bits, the parity, the protocol, and the SyberTrol’s address are set up. 
 

 

 
  
  
Figure 3 
  

  
To establish initial communication with the SyberTrol under “File”, select Login/Relogin.  The screen shown in 
Step 2 will appear.  Entering the correct passcode and pressing “ENTER” should establish communications with 
the SyberTrol.  Once established, Mode, located at the bottom right hand corner of the screen, will indicate Online 
or Read Only.  Online will indicate that the SyberTrol is not in the program mode and the correct access code was 
entered.  Read Only will indicate that either an incorrect access code was entered or that the SyberTrol is in the 
Program Mode. 

  
  

  
 

                         Mode of Operation

Figure 4 
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To Run the Program 

1.  Using the mouse, locate the program group SyberMate for SyberTrol and double click on the FMC icon. 

  
  

  
  

Figure 5 
  
  
  

 2.  To access the SyberTrol data, the correct password or PIN number must be entered on this screen. 
  
  
  

  
  

  
Figure 6
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If the incorrect passcode is entered, the SyberMate will remain in the Offline Mode. If the correct pass-
code is entered, the SyberMate will go on-line with the SyberTrol (communications port, baud rate, data 
bits, etc. must be programmed the same at the computer and the SyberTrol).  If the SyberTrol is in the 
program mode, the SyberMate will go into the Read Only Mode where data can be read but not changed. 

 
 
 
 
 
 
 
 
 
 

 
 
 
Figure 7 
 
 
The data/functions that can be accessed or accom-
plished from this screen are as follows: 

File 

New SyberTrol, a new SyberTrol file will be created. 

Select SyberTrol, a list of the SyberTrol files that are 
saved will be displayed and can be selected. 

 
Save Changes, saves the changes in the current file 
and if on-line with the SyberTrol, sends an “update 
software” command causing all changes to take ef-
fect. This is equivalent to exiting the program mode. 

Save Changes As, pops up a screen where a new 
file name and communications address can be en-
tered along with the site name. 

Print, prints either the current directory or all the pa-
rameters for the current SyberTrol file. 

New File 

 Open File 

Save Changes 
Save Changes As... 

Read Directory

Read All Directories 

Dump Directory 

Dump All Directories 

Help 
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Comm Setup, pops up a screen where the Syber-
Mate can be configured for communications with the 
SyberTrol. The communications port, baud rate, data 
bits, parity, protocol, and address are configurable. 

Note:  In order to communicate with the SyberTrol this screen must be 
setup identical to the setup in the SyberTrol for the selected communi-
cations port. 

Login/Relogin, when in offline or Read Only mode, 
selecting Login/Relogin pops up the login screen 
where the passcode can be entered. If the passcode 
is correct and the SyberTrol is in the run mode, the 
SyberMate will go online with the SyberTrol. 

Options, sets up the operation of the SyberMate. 
When “Print” is selected, the data can be printed to a 
printer or a file. It can be presented either in the de-
fault format or a table format. The computer can be 
set to beep on errors or when the Read/Dump is 
completed. 

Exit, exits the program. 

Edit 

Not functional in this revision of the SyberMate. 

Configure 

System, pops up a screen where the system parame-
ters for general data, measurement units, and reports 
can be programmed and/or displayed. 

Skid, when selected, allows the operator to view or 
program one of the skids in the system. The skid 
number is selected by moving the cursor to the re-
quired tab (1, 2, or 3) and clicking on it. From this 
screen the skid data can be programmed. 

Meter, when selected, allows the operator to view or 
program one of the meters in the system. After the 
meter is selected, the meter parameters for general 
data, volumetric data, flow control data, flow control 
I/O, and miscellaneous I/O can be programmed 
and/or displayed. 

Product, when selected, allows the operator to view 
or program one of the products in the system. After 
the product is selected, the product parameters for 
general data, pressure data, and meter factor data 
can be programmed and/or displayed. 

I/O Points, allows for the selection of the digital I/O 
points, the analog I/O points, or the pulse I/O points 
for programming and displaying. 

Communications, allows the selection of the commu-
nication port to be programmed and/or displayed. 

Prover, when selected, allows the operator to view or 
program the prover or provers that can be set up in 
the system. 

User Data, when selected, allows the operator to 
view or program the algebraic variable or the Boo-
lean variable in the SyberTrol. The operator can se-
lect the registers by choosing the required number of 
the offset in the popup window. (Values are from 1 to 
99.) 

Alarms - System, when selected allows the operator 
to view or program how the system hardware or 
user/misc alarms will operate if they occur. They can 
be programmed to either print to a log, activate the 
alarm contact, shut down the batch, clear any ac-
knowledged alarm, or to display an alarm message 
on the display of the SyberTrol. See alarm descrip-
tion in the Operators Manual MN09045. 

Alarms - Meter, when selected allows the operator to 
view or program how the alarms associated with the 
meters will operate if they occur. They have the same 
options as described in the System alarms. the 
alarms in this menu are broken down into four sec-
tions meter I/O, a second screen for meter I/O, a 
user/misc. screen and a transducer screen. See 
alarm description in the Operators Manual MN09045. 

Alarms - Meter (Prover), when selected allows the 
operator to view or program the alarms associated 
with the prover. They have the same options as de-
scribed in the System alarms. The alarms in this 
menu are broken down into four screens, the first 
three screens are the prover alarms and the fourth 
screen is for the inlet and outlet temperature and 
pressure alarms. See alarm description in the Opera-
tors Manual MN09045. 

Auto Configure, not functional in this revision of the 
SyberMate. 

Read SyberTrol, selects the data that is to be read 
from the SyberTrol. The choices are to read all the 
data from the SyberTrol, or just the current directory. 

Dump to SyberTrol, selects the data from the current 
file that is to be dumped to the SyberTrol. The 
choices are to dump all the data, or to dump the data 
from the current directory. 
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Inquire  

Alarms, when selected, will retrieve the system 
alarms or each of the meter’s alarms from the Syber-
Trol. 

Batch Data, will retrieve the batch information for the 
skids or each of the meters from the SyberTrol. 

Run Data, retrieves the data from the SyberTrol for 
the meter or meters, digital I/O point, analog I/O 
point, and/or the pulse I/O point. 

Prove Data, retrieves the general information about 
the prover, trip data, and quick trip data. 

Timers, retrieves the current values of the timers 
from the SyberTrol. 

Tools 

Report Generator, not functional in this revision of the 
SyberMate. 

Report Editor, when selected, will provide the opera-
tor with the tools necessary to create a configurable 
report. (See “Creating Configurable Reports” for de-
tails.) 

Display Editor, when selected, will provide the opera-
tor with the tools necessary to create a configurable 
display. (See “Creating Configurable Displays” for de-
tails.) 

Remote Display, not functional in this revision of the 
SyberMate. 

Translator, when selected, will provide the operator 
with the tools necessary to change the default mes-
sages that are resident in the SyberTrol. (See “Trans-
lator” for details.) 

Equation Editor, when selected, will provide the op-
erator with the tools necessary to create Boolean and 
algebraic expressions that can be used to set up op-
erations in the SyberTrol that were not available in 
the default firmware. (See “Equation Editor” for de-
tails. 

Window 

Not functional in this revision of the SyberMate. 
 
Help 
 
Provides help on various features of the SyberMate. 

 
Selecting an Existing File 

To select a file that has been previously created two 
options are available, one from the File name “Select 
SyberTrol” and one from the Icon shown on the third 
line of the screen (See Figure 7 for location). When 
the “Select SyberTrol” is selected a screen will ap-
pear listing the existing files and the desired file can 
be selected and opened, edited deleted or a file can 
be added.  When the file is highlighted and the OK 
button is pressed is “Passcode Entry” screen will ap-
pear.  The passcode can be entered to go online with 
the SyberTrol or the “Offline Mode” Button can be 
pressed to work on the file offline. 

Creating a New File 

To create a new data file two options are available, 
one from the File menu “New SyberTrol” and one 
from the Icon shown on the third line of the screen 
(See Figure 7 for location).  When the “New Syber-
Trol” is selected a screen will appear where the op-
erator can enter a new file name, a communication 
address, where to initialize the data from and the Site 
Name.  Once this data is entered the screen will ap-
pear asking for the Passcode Entry, if the new file is 
to be created from a current SyberTrol the passcode 
can be entered and data uploaded to the new file or 
the operator can press the “offline” button and create 
the new file offline. 

Saving Data 

To save a newly created or edited file two options are 
available, one from the File menu, “Save Changes” 
or “Save Changes as...”, the other from selecting the 
Icons from the screen will perform the same functions 
(See Figure 7 for location).  If “Save Changes” is se-
lected the changes will be saved in the current file 
and if online with the SyberTrol will download the 
changes to the SyberTrol.  If “Save Changes As...” is 
selected a popup screen will appear where a new file 
name can be entered and the changes will be down 
loaded to the SyberTrol if in the Online Mode of op-
eration. 

 
Read Data from SyberTrol 
To read data from an existing SyberTrol two options 
are available, one from the Configure Menu “Read 
SyberTrol” and one from the Icons shown on the third 
line of the screen (See Figure 7 for location).  From 
either of these options the operator can select to ei-
ther read a directory or all the directories from the  
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existing SyberTrol.  When “Read a Directory” is se-
lected a directory from the Configure Menu must be 
selected prior to pressing the Read Directory Button. 
 When the computer is reading the data from the Sy-
berTrol a screen will appear where the directory be-
ing read is displayed as well on “ABORT” Button.  
The “ABORT” Button will halt the reading of the data 
from the SyberTrol.  When the reading of the data is 
complete the program will return to the previous 
screen. 
 
Dump Data To the SyberTrol 

To dump data from the current file on the SyberMate 
two options are available, one from the Configure 
Menu “Dump to SyberTrol” and one from the Icons 
shown on the third line of the screen (See Figure 7 
for location).  From either of these options the opera-
tor can select either dump directory or dump all direc-
tories to SyberTrol.  When dump a directory is se-
lected a directory from the Configure Menu must be 
selected prior to pressing the dump directory button.  
When the SyberMate is dumping data to the Syber-
Trol a screen will appear where the directory being 
dumped is displayed as well as an “ABORT” button. 
The “ABORT” button will halt the data being down-
loaded to the SyberTrol.  When the downloading of 
the data is complete the program will return to the 
previous screen. 

On-Line Help 

To access the built in help function of SyberTrol, us-
ing the mouse, click on the word Help or using the 
keyboard type the letter H.  This action will cause a 
menu to appear where Contents or About can be se-
lected.  Selecting Contents will produce a Help Index 
were a topic can be selected and by either pressing 
‘ENTER’ on the keyboard or clicking on the ‘Show 
Topic’ button with the mouse the help information will 
be displayed.  From this screen the operator can con-
tinue with the Help information for a different subject 
by choosing the ‘Show Index’ button or can close the 
help session by selecting the ‘CLOSE’ button. 
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Figure 8 
 
 
 
Selecting About from the Help menu will display the following screen: 
 
 
 

 
 

Figure 9
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Creating Displays 

Create or open an existing display by selecting “Tools” from the main SyberMate screen as shown in Figure 10. 

 
 

  
 
 
Figure 10 
 

Select “Displays Editor” from the menu.  The following window will appear. 

 

 

 

Figure 11  
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A number of functions can be performed from this display.  Each of the main functions has a menu of items or 
subfunctions, as indicated below: 

File New 
 

Selects the   Select the name, number of columns, number of lines per page, and 
number of pages from the popup window.  See Figure 12 below. 

Open  This command lists stored displays available for selection. 

Save  This command saves changes to the current file. 

Save As Use the popup window to enter a file name and select a location for the file on the 
computer. 

Report/Display Setup  

 

Use the popup window to change the name, number of columns, number of lines 
per page, and number of pages in a report.  The name is the only item that can be 
changed for a display. 

 

 

 

 

  
 
Figure 12 
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Retrieve from SyberTrol This command is used to upload a configurable display from the SyberTrol to the 

SyberMate. 

Update SyberTrol Use the popup window to select the location of the display on the SyberTrol.  See 
Figure 13 below. 

 
 
 

 
 
 
Figure 13 
 
 

Exit This command closes the Display Editor. 

Edit - Insert New Item Use the “Edit Display Item” screen to customize the following information.  See 
Figure 14 below. 

 
 
 

 
 
 
Figure 14
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Row Indicates the row on which the data to be displayed is entered. 

Column Indicates the column in which the data to be displayed is entered. 
 

Type Selects the type of data to be entered on the screen. The choices are as follows: 

  User-defined text entry Displays text typed in the Current Value entry. 

  Database Value Displays the database value for a selected register. 

  Database Description Displays the database value description for a selected register. 

Database Register ID Displays the register number for an item dragged here from a Configure or Inquire 
Table or Workbook; or, if a register number is known, it can be entered here 
directly. 

Current Value Displays the current value of the register; or, if a user-defined text entry is 
selected as type, the text is entered here. 

Format String The format string designates the type of data to be displayed.  The strings used in 
the SyberTrol are based on IEEE standards and are as follows: 

  %uc Data labeled as “Byte” on the SyberTrol (unsigned character) 

  %f Data labeled as “DP Float” or “Double Precision Floating Point.”  Specify the 
length of the numeric data in this field.  (The SyberTrol stores all double precision 
floating point data as ten digits.)  Using the number 0.2 between the “%” and the 
“f” right-justifies the data five places and truncates the data to two decimal places 
(i.e., %0.2f).  This field can be used to line up the numerical data on the screen by 
entering an “8” between the “%” sign and the “f”  (i.e., %8f).  If the requirement is 
to both line up the data and truncate to two decimal places, the entry would be 
%8.2f. 

  %d Data labeled as an integer in the SyberTrol database. 

  %s Data labeled as a string in the SyberTrol, consisting of multiple characters. 

Font This command selects the font and point size of the text on the SyberTrol display. 
The selections are: 

  System Font (Normal) 
  System Font (Italic) 
  System Font (Bold) 
  Arial 11 point (Normal) 
  Arial 11 point (Italic) 
  Arial 11 point (Bold) 
  Arial 18 point (Bold) 
  Arial 22 point (Bold) 

Note: The font size will not change on the Display Editor.  To view the actual size, download the 
display to the SyberTrol.  Be careful not to overlap fields when using larger type sizes. 
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Color This command selects the color of the data displayed on the SyberTrol screen.  

The selections are: 

  White on Black 
  Light Gray on Black 
  Dark Gray on Black 
  White on Dark Gray 
  Light Gray on Dark Gray 
  Black on Dark Gray 
  White on Light Gray 
  Dark Gray on Light Gray 
  Black on Light Gray 
  Light Gray on White 
  Dark Gray on White 
  Black on White 
Note: Combinations of light gray and dark gray may not be readable. 

Cut The item highlighted on the Display Editor will be cut from the display and stored 
in the clipboard. 

Copy The item highlighted on the Display Editor will be copied to the clipboard. 

Paste The information stored in the clipboard will be pasted to the upper left-hand 
corner of the Editor window. 

Select All This command is not functional in this revision of the SyberMate. 
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New Display File 
To create a new file, 
 
1. Select “File” from the Display Editor window. 

2. Select “New” from the menu. 

3. The popup menu shown in Figure 15 below will 
appear.  Enter the name for the new display in 
the highlighted field.  The entry can contain up to 
twenty characters. 

4. A new display can now be created.  There are 
two ways to enter the data on the display.  The 
easiest method is to drag the Display Editor 
screen to one side of the computer screen, then 
click on either “Configure” or “Inquire” on the Sy-
berMate screen.  This allows system, meter, or 
product information to be displayed.  To enter the 
information in the display, click on the item to ob-
tain an arrow and page symbol, then drag the in-
formation to the display.  The other method of 
creating a display is to use the Edit menu on the 

 
Display Editor screen.  Select Edit, then “Insert 
New Item,” to obtain the Edit Display Item 
screen.  If you know the database register num-
ber, you can use this screen to enter data on the 
display. 

In most cases, both methods will be used to create 
displays.  Use the grab method to get data from the 
database.  Use the Insert New Item screen to add 
and locate user text. 

Once a display has been created and reviewed, use 
the Save As option from the File menu on the Display 
Editor screen to save the data.  Choosing Save As 
will obtain a popup screen on which to enter the di-
rectory, subdirectory, and file name of the new dis-
play.  When the information has been entered, click 
on the OK button to save the display.  

Assuming that communications have been estab-
lished between the computer and the SyberTrol, the 
display can be downloaded to the SyberTrol by se-
lecting “Update SyberTrol” from the File menu. 

 

 

 

Figure 15
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Figure 16 

 
 

 

To create the display in Figure 16 above, do the fol-
lowing. 

1. From the SyberMate display, choose “Re-
ports/Displays.” 

2. From the Reports/Displays menu, select “Edit 
Display.” 

3. From the Display Editor, select “File.” 

4. From the File menu, select New. 

5. To name the new display, choose “Options” from 
the Current Report/Display menu. Type “Exam-
ple” and press the OK button. 

6. On the blank Display Editor screen, choose Edit. 

7. From the Edit menu, select “Insert New Item.” 

8. To enter “Meter Run #3,” the title of the display, 
do the following: 

a) On the Edit Display Item screen, position the 
data in Row 1, Column 14.  This centers the 
12-character title on the 40-column display. 

b) On the same screen, choose “User Defined 
Text Entry” for “Type.” 

c) Move the cursor to “Current Value,” delete 
value, and type in “Meter Run #3.” 

d) Press the OK button.  The title “Meter Run 
#3” is now centered on the first line of the 
new display. 

9. Move the Display Editor screen to the right-hand 
side of the computer screen to allow work to be 
done on both screens simultaneously. 
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10. To add the date and time to the display, do the 
following: 

a) Choose “Configure” on the SyberMate 
screen. 

b) From the Configure menu, select “System.” 

c) The system directory screen will be dis-
played.  Choose “General” to display a 
screen with the date and time in the right-
hand corner.  Using the mouse, select the 
time data box.  Hold the left mouse button 
down and move the time to line 2 on the 
right-hand side of the Display Editor screen. 
Repeat this step to move the date to line 2, 
column 7 of the Display Editor. 

d) Set up the literals “Date” and “Time” on the 
Display Editor in either of two ways: 

i) In the Display Editor, click on the date, 
highlighting it, then move the cursor and 
click on Edit.  Move the cursor to Copy 
and click to copy the date to the clip-
board. 

ii) Click on Edit and select Paste to insert 
the date in line 1, column 1 of the Display 
Editor.  Use the left mouse button to click 
on the date and move it to row 2, column 
1. 

iii) Double-click on the date that was just 
moved.  From the Edit Display Item 
screen, change the type to “Database 
Description” and press the OK button. 

iv) Repeat these three steps to enter the 
time, except move it to row 2, column 25. 
When you are finished, the word “time” 
will be located in front of the actual time. 

e) Another way of entering the literals for date 
and time is to do the following: 

i) Click on Edit, then click on “Insert New 
Item” from the menu. 

ii) From the Edit Display Item screen, 
change the row indicator to 2, leave the 
type at “User Defined Text Entry,” and 
type the word “Date” in the Current Value 
box.  Delete the word “value” and press 
the OK button.  The word “Date” will ap-
pear on the Display Editor in row 2, col-
umn 1. 

iii) Repeat these two steps to enter the time, 
except change the row indicator to 2 and 
the column indicator to 25. 

f) Line 6 is the “Batch Preset Value” for meter 
#3.  “Batch Data”  is found under “Inquire” on 
the SyberMate screen.  Click on “Inquire,” 
then move down to “Batch Data.”  Clicking 
“Batch Data” will produce a menu on which 
to select system or a meter.  Choose “Meter 
3.” 

g) From the Batch Data-Meter 3 screen, select 
the value in register 5110003.  Hold down 
the left mouse button to grab the value, then 
drag it to the Display Editor and drop it in 
place.  The “Batch Preset” value is a floating 
point number stored as ten digits in the data-
base.  All or part of this number can be 
shown on the display. 

h) Double-click on “Batch Preset Value” on the 
Display Editor screen to obtain the Edit Dis-
play Item screen.  On this screen, you can 
change the position and font, and format the 
string. 
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i) The starting position of the data is row 6, 
column 25.  If these numbers are not 
those shown on the screen, change them 
to read “Row 6, Column 25.” 

ii) In order to line up all the numerical data 
on the screen, the largest number of dig-
its will be eight (five whole places and 
two decimal places).  Enter “8.0f” in the 
format string box to indicate that the 
number will be right-justified to column 
33 (column 25 + 8); 0 decimal places will 
be displayed; and the number is a float-
ing point number. 

iii) To change the font, select a new one 
from the font selection box.  A change in 
type size will not appear on the Display 
Editor.  The SyberTrol display will need 
to be viewed to determine whether a font 
size change affects the location of other 
data.  Too large a type size may result in 
overlapping data.  When the changes 
have been made on the Edit Display Item 
screen, click on the OK button to return 
to the Display Editor. 

i) Enter the literal “Batch Preset” on the Display 
Editor by following the same procedure that 
was used to enter the date and time.  The lit-
eral can be entered as a New Data Item, or 
copy the Preset Value location on the display 
and change it to the database description on 
the Edit Display Item screen. 

Set up the remainder of the items on the display by 
locating the item in the database and moving it to the 
Display Editor, as described above.  The table on the 
following page indicates the item, where found in the 
database, the type of entry, the register number, how 
to set up the format string, the row, and the starting 
column for the data.  
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Item Type Register 
Format 
String Row Column Where Found 

Meter Run #3 User Defined Text --- %s 1 14 --- 

Date Database Description 700 %s 2 1 Configure/System/General 

10/29/96 Database Value 700 %s 2 7 Configure/System/General 

Time Database Description 800 %s 2 25 Configure/System/General 

1:20:16 PM Database Value 800 %s 2 30 Configure/System/General 

Meter ID User Defined Text --- %s 2 30 --- 

FQT 1003 Database Value 10003 %s 3 21 Configure/Meter/Meter #3/ 
DP Float 

Batch Preset Database Description 5110003 %s 6 1 Inquire/Batch Data/ 
Meter #3/DP Float 

10000 Database Value 5110003 %8.0f 6 25 Inquire/Batch Data/ 
Meter #3/DP Float 

BBL Database Value 100 %s 6 34 Configure/System/General 

Product Name Database Description 20003 %s 8 1 Configure/Product/ 
Product 3/General 

DIESEL Database Value 20003 %s 8 28 Configure/Product/ 
Product 3/General 

Delivered Volume Database Description 5120103 %s 10 1 Inquire/Run Data/Meter/3/ 
DP Float 

0 Database Value 5120103 %8.2f 10 25 Inquire/Run Data/Meter/3/ 
DP Float 

BBL Database Value 100 %s 10 34 Configure/System/General 

Remaining Volume Database Description 5120203 %s 12 1 Inquire/Run Data/Meter/3/ 
DP Float 

10000 Database Value 5120203 %8.2f 12 25 Inquire/Run Data/Meter/3/ 
DP Float 

BBL Database Value 100 %s 12 34 Configure/System/General 

High Flow Rate 
Setting 

User-defined Text Entry --- %s 14 1 --- 

1700 Database Value 5010903 %8.0f 14 25 Configure/Meter/Meter #3/ 
Flow Control 

BPH Database Value 0 %s 14 34 Configure/System/General 

Current Flow Rate Database Description 5120303 %s 16 1 Inquire/Run Data/Meter/3/ 
DP Float 

0 Database Value 5120303 %8.0f 16 25 Inquire/Run Data/Meter/3/ 
DP Float 

BPH Database Value 0 %s 16 34 Configure/System/General 
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Creating Configurable Reports 

Create or open an existing report by selecting “Tools” from the main SyberMate screen as shown in Figure 17. 

 
 

  
 

Figure 17 
 
 

Select “Report Editor” from the menu.  The following display will appear. 

 

 

 

  

Figure 18
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A number of functions can be performed from this display.  Each of the main functions has a menu of items or 
subfunctions, as indicated below: 

File New 
 

  Select the name, number of columns, number of lines per page, and number of 
pages from the popup window.  See Figure 19 below. 

Open  This command lists stored reports available for selection. 

Save  This command saves changes to the current file. 

Save As Use the popup window to enter a file name and select a location for the file on the 
computer. 

Report/Display Setup  

 

Use the popup window (see Figure 19 below) to change the name, number of 
columns, number of lines per page, and number of pages in the report. 

 
 
 
 

 

  

Figure 19 
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Retrieve from SyberTrol This command is used to retrieve a configurable report from the SyberTrol. 

Update SyberTrol Use the popup window to select the location of the display on the SyberTrol. See 
Figure 20 below. 

 
 
 
 

 
 
 
Figure 20 
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Exit This command closes the Report Editor. 

Edit - Insert New Item Use the “Edit Display Item” screen to customize the following information. See 
Figure 21 below. 

 
 
 

 
 
 
Figure 21 
 
 
 

Row Indicates the row on which the data to be reported is entered. 

Column Indicates the column in which the data to be reported is entered. 

Type Selects the type of data to be entered on the screen. The choices are as follows: 

  User-defined text entry Displays text typed in the Current Value entry. 

  Database Value Displays the database value for a selected register. 

  Database Description Displays the database value description for a selected register. 

Database Register ID Displays the register number for an item dragged here from a Configure or Inquire 
Table or Workbook; or, if a register number is known, it can be entered here 
directly. 

Current Value Displays the current value of the register; or, if a user-defined text entry is 
selected as type, the text is entered here. 
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Format String The format string designates the type of data to be displayed.  The strings used in 

the SyberTrol are based on IEEE standards and are as follows: 

  %uc Data labeled as “Byte” on the SyberTrol (unsigned character). 

  %f Data labeled as “DP Float” or “Double Precision Floating Point.”  Specify the 
length of the numeric data in this field.  (The SyberTrol stores all double precision 
floating point data as ten digits.)  Using the number 0.2 between the “%” and the 
“f” right-justifies the data five places and truncates the data to two decimal places 
(i.e., %0.2f).  This field can be used to line up the numerical data on the screen by 
entering an “8” between the “%” sign and the “f”  (i.e., %8f).  If the requirement is 
to both line up the data and truncate to two decimal places, the entry would be 
%8.2f. 

  %d Data labeled as an integer in the SyberTrol database. 

  %s Data labeled as a string in the SyberTrol, consisting of multiple characters. 

Cut The item highlighted on the Report Editor will be cut from the report and stored in 
the clipboard. 

Copy The item highlighted on the Report Editor will be copied to the clipboard. 

Paste The information stored in the clipboard will be pasted to the first row and first 
column of the report. 

Select All This command is not functional in this revision of the SyberMate. 
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New Report File 
To create a new file, 
 
1. Select “File” from the Report Editor window. 

2. Select “New” from the menu. 

3. The popup menu shown in Figure 22 below will 
appear.  Enter the name for the new report in the 
highlighted field.  The entry can contain up to 
twenty characters. After the name of the report 
has been entered, the number of columns, num-
ber of lines, and the number of pages can be set 
up.  The default values are 80 columns, 66 lines 
per page, and 1 page.  When these values are 
set, press “Enter” or click on OK.  The program 
will return to the Report Editor screen. 

 
A new report can now be created.  There are two 
ways to enter the data on the report.  The easiest 
method is to drag the Report Editor screen to one 
side of the computer screen, then click on either 
“Configure” or “Inquire” on the SyberMate screen. 
This allows system, meter, or product information to 

 
be displayed.  To enter the information in the report, 
click on the item to obtain an arrow and page symbol, 
then drag the information to the report.  The other 
method of creating a report is to use the Edit menu 
on the Report Editor screen.  Select Edit, then “Insert 
New Item,” to obtain the Edit Report Item screen.  If 
you know the database register number, you can use 
this screen to enter data on the report. In most cases, 
both methods will be used to create reports. Use the 
grab method to get data from the database. Use the 
Insert New Item screen to add and locate user text. 

Once a report has been created and reviewed, use 
the Save As option from the File menu on the Report 
Editor screen to save the data.  Choosing Save As 
will obtain a popup screen on which to enter the di-
rectory, subdirectory, and file name of the new report. 
 When the information has been entered, click on the 
OK button to save the report. Assuming that commu-
nications have been established between the com-
puter and the SyberTrol, the report can be down-
loaded to the SyberTrol by selecting “Update Syber-
Trol” from the File menu. 

 
 
 

 
  
 

Figure 22
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Figure 23 
 
 
To create the report in Figure 23 above, do the fol-
lowing. 

1. From the SyberMate display, choose “Re-
ports/Displays.” 

2. From the Reports/Displays menu, select “Edit 
Report.” 

3. From the Report Editor, select “File.” 

4. From the File menu, select New. 

5. To name the new report, choose “Options” from 
the Current Report/Display menu.  Type “Exam-
ple” and press the OK button. 

6. On the blank Report Editor screen, choose Edit. 

7. From the Edit menu, select “Insert New Item.” 

8. To enter “Meter #3 Daily Report,” the title of the 
display, do the following: 

a) On the Edit Report Item screen, position the 
data in Row 1, Column 30.  This centers the 
title on the 80-column report. 

b) On the same screen, choose “User Defined 
Text Entry” for “Type.” 

c) Move the cursor to “Current Value,” delete 
value, and type in “Meter #3 Daily Report.” 

d) Press the OK button. The title “Meter #3 
Daily Report” is now centered on the first line 
of the new display. 

9. Move the Report Editor screen to the right-hand 
side of the computer screen to allow work to be 
done on both screens simultaneously. 

10. To add the date and time to the display, do the 
following: 

a) Choose “Configure” on the SyberMate 
screen. 

b) From the Configure menu, select “System.” 

c) The system directory screen will be dis-
played.  Choose “General” to display a 
screen with the date and time in the right-
hand corner.  Using the mouse, select the 
time data box.  Hold the left mouse button 
down and move the time to line 2, column 54 
of the Report Editor screen. Repeat this step 
to move the date to line 2, column 20 of the 
Report Editor. 

d) Set up the literals “Date” and “Time” on the 
Report Editor in either of two ways: 

i) In the Report Editor, click on the date, 
highlighting it, then move the cursor and 
click on Edit.  Move the cursor to Copy 
and click to copy the date to the clip-
board. 
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ii) Click on Edit and select Paste to insert 
the date in line 1, column 1 of the Report 
Editor.  Use the left mouse button to click 
on the date and move it to row 2, column 
5. 

iii) Double-click on the date that was just 
moved.  From the Edit Report Item 
screen, change the type to “Database 
Description” and press the OK button. 
The word “date” will replace the actual 
date in row 2, column 5. 

iv) Repeat these three steps to enter the 
time, except move it to row 2, column 40. 
When you are finished, the word “time” 
will be located in front of the actual time. 

e) Another way of entering the literals for date 
and time is to do the following: 

i) Click on Edit, then click on “Insert New 
Item” from the menu. 

ii) From the Edit Report Item screen, 
change the row indicator to 2 and the 
column indicator to 5, leave the type at 
“User Defined Text Entry,” and type the 
word “Date” in the Current Value box. 
Delete the word “value” and press the 
OK button.  The word “Date” will appear 
on the Display Editor in row 2, column 5. 

iii) Repeat these two steps to enter the time, 
except change the row indicator to 2 and 
the column indicator to 40. 

f) Line 5, column 40 is the “Batch Preset Value” 
for meter #3.  “Batch Data”  is found under 
“Inquire” on the SyberMate screen.  Click on 
“Inquire,” then move down to “Batch Data.”  
Clicking “Batch Data” will produce a menu on 
which to select system or a meter.  Choose 
“Meter 3.” 

g) From the Batch Data-Meter 3 screen, select 
the value in register 5110003.  Hold down 
the left mouse button to grab the value, then 
drag it to the Report Editor and drop it in 
place.  The “Batch Preset” value is a floating 
point number stored as ten digits in the data-
base.  All or part of this number can be 
shown on the display. 

h) Double-click on “Batch Preset Value” on the 
Report Editor screen to obtain the Edit Re-
port Item screen.  On this screen, you can 
change the position and font, and format the 
string. 

i) The starting position of the data is row 5, 
column 54.  If these numbers are not 
those shown on the screen, change them 
to read “Row 5, Column 54.” 

ii) In order to line up all the numerical data 
on the screen, the largest number of dig-
its will be eight (five whole places and 
two decimal places).  Enter “8.0f” in the 
format string box to indicate that the 
number will be right-justified to column 
62 (column 54 + 8); 0 decimal places will 
be displayed; and the number is a float-
ing point number. 

i) Enter the literal “Batch Preset” on the Report 
Editor by following the same procedure that 
was used to enter the date and time.  The lit-
eral can be entered as a New Data Item, or 
copy the Preset Value location on the display 
and change it to the database description on 
the Edit Report Item screen. 

Set up the remainder of the items on the display by 
locating the item in the database and moving it to the 
Report Editor, as described above.  The table on the 
following page indicates the item, where found in the 
database, the type of entry, the register number, how 
to set up the format string, the row, and the starting 
column for the data.  

When the above instructions are followed and the 
data is entered for the configurable display, the data 
will appear on the SyberTrol display as shown in Fig-
ure 24 below.  Note that through the format string, all 
the numeric data is right-justified to the eighth posi-
tion.
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  12345678901234567890123456789012345678901234567890123456789012345678901234567890 
1                              Meter #3 Daily Report   
2     Date           11/26/96            Time          9:21:05 AM  
3     Meter  ID      FQT   312           K Factor     1000.00 
4     High Flow Rate      1700           Min Flow Rate     40 
5     Batch Number   1                   Batch Preset   10000    
6  
7                    Delivered Volume              5000.25  
8                    Meter Pulses               5000250.00 
9                    Gross Batch                      4999 
0                    GST Batch                        4981 
1                    Current Flow Rate                1500 
2                    Current Mfac                   0.9999 
3                    Current BS$W                     0.00 
4                    Current Temperature             62.10 
5                    Current CTL                    0.9989 
6                    Current Density                 47.00 
7                     
8                    Batch Avg Mfac                 0.9998 
9                    Batch Avg Temp                  66.70 
0                    Batch Avg Dens                  46.70 
1 
2 
3 
4 
5 
6                              Signature ______________________ 
7 
8                              Title __________________________ 
9 
0 
 
 

Figure 24 
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Item Type Register 
Format 
String Row Column Where Found 

Meter #3 Daily Report User-defined Text Entry --- %s 1 30 --- 

Date Database Description 700 %s 2 5 Configure/System/General 

11/26/96 Database Value 700 %s 2 20 Configure/System/General 

Time Database Description 800 %s 2 40 Configure/System/General 

9:21:05 AM Database Value 800 %s 2 54 Configure/System/General 

Meter ID User-defined Text Entry --- %s 3 5 --- 

FQT^ ^ ^  312 Database Value 10001 %s 3 20 Configure/Meter/Meter 3/ 
General 

K Factor Database Description 5010001 %s 3 40 Configure/Meter/Meter 3/ 
General 

1000.00 Database Value 5010001 %8.2f 3 54 Configure/Meter/Meter 3/ 
General 

High Flow Rate Database Description 5010901 %s 4 5 Configure/Meter/Meter 3/ 
Flow Control 

1700 Database Value 5010901 %8.0f 4 20 Configure/Meter/Meter 3/ 
Flow Control 

Min Flow Rate Database Description 5011101 %s 4 40 Configure/Meter/Meter 3/ 
Flow Control 

40 Database Value 5011101 %8.0f 4 54 Configure/Meter/Meter 3/ 
Flow Control 

Batch Number Database Description 2120003 %s 5 5 Inquire/Run 
Data/Meter/INT 

1 Database Value 2120003 %d 5 20 Inquire/Run 
Data/Meter/INT 

Batch Preset Database Description 5110003 %s 5 40 Inquire/Run Data/Meter/ 
DP Float 

10000 Database Value 5110003 %8.0f 5 54 Inquire/Run Data/Meter/ 
DP Float 

Delivered Volume Database Description 5120103 %s 7 20 Inquire/Run Data/Meter/ 
DP Float 

5000.25 Database Value 5120103 %8.2f 7 50 Inquire/Run Data/Meter/ 
DP Float 

Meter Pulses Database Description 5120803 %s 8 20 Inquire/Run Data/Meter/ 
DP Float 

5000250.00 Database Value 5120803 %8.2f 8 50 Inquire/Run Data/Meter/ 
DP Float 

Gross Batch Database Description 5121003 %s 9 20 Inquire/Run Data/Meter/ 
DP Float 

4999 Database Value 5121003 %8.0f 9 50 Inquire/Run Data/Meter/ 
DP Float 

GST Batch Database Description 5121103 %s 10 20 Inquire/Run Data/Meter/ 
DP Float 
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Item Type Register 
Format 
String Row Column Where Found 

4981 Database Value 5121103 %0.8f 10 50 Inquire/Run Data/Meter/ 
DP Float 

Current Flow Rate Database Description 5120303 %s 11 20 Inquire/Run Data/Meter/ 
DP Float 

1500 Database Value 5120303 %8.0f 11 50 Inquire/Run Data/Meter/ 
DP Float 

Current Mfac Database Description 5120403 %s 12 20 Inquire/Run Data/Meter/ 
DP Float 

0.9999 Database Value 5120403 %8.4 12 50 Inquire/Run Data/Meter/ 
DP Float 

Current BS&W Database Description 5120503 %s 13 20 Inquire/Run Data/Meter/ 
DP Float 

0.00 Database Value 5120503 %8.2f 13 50 Inquire/Run Data/Meter/ 
DP Float 

Current Temperature Database Description 5121903 %s 14 5 Inquire/Run Data/Meter/ 
DP Float 

62.1 Database Value 5121903 %8.2f 14 30 Inquire/Run Data/Meter/ 
DP Float 

Current Density Database Description 5122103 %s 16 5 Inquire/Run Data/Meter/ 
DP Float 

47.0 Database Value 5122103 %8.2f 16 30 Inquire/Run Data/Meter/ 
DP Float 

Current CTL Database Description 5122203 %s 14 45 Inquire/Run Data/Meter/ 
DP Float 

0.9989 Database Description 5122203 %8.4f 14 60 Inquire/Run Data/Meter/ 
DP Float 

Batch AVG Mfac Database Description 5120603 %s 18 20 Inquire/Run Data/Meter/ 
DP Float 

0.9998 Database Value 5120603 %8.4f 18 50 Inquire/Run Data/Meter/ 
DP Float 

Batch AVG Temp Database Description 5121503 %s 18 20 Inquire/Run Data/Meter/ 
DP Float 

66.70 Database Description 5121503 %8.2f 19 50 Inquire/Run Data/Meter/ 
DP Float 

Batch AVG Den Database Description 5121703 %s 21 20 Inquire/Run Data/Meter/ 
DP Float 

46.7 API Database Value 5121703 %8.4f 21 50 Inquire/Run Data/Meter/ 
DP Float 

Signature _________ User-defined Text Entry --- %s 26 30 Inquire/Run Data/Meter/ 
DP Float 

Title ______________ User-defined Text Entry --- %s 28 30 Inquire/Run Data/Meter/ 
DP Float 
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Translator 

The translator provided by the SyberTrol can be used to modify or translate any message that resides in the Sy-
berTrol. Currently the messages can be changed or translated into any language that uses the Latin character set 
that is resident in the SyberTrol. Also available in this version of the SyberMate is the Cyrillic (PC-866) character 
set. For other character sets, contact the factory for availability. 

To access the translator, select Tools from the main SyberMate screen. Then, using the mouse or pressing “T” on 
the keyboard, select “Translator.” The following screen will be displayed. 
 
 

 

Figure 25 
 

From this screen, all the literals that are resident in the SyberTrol are accessible and can be changed. There are 
two items on the first line of the screen, File and Search, that provide the functions that can be used with the 
translator function of the SyberTrol. 

When “File” is selected, a drop down menu is displayed that has the following actions: 

New Provides a new file to be worked on, if a previous file was being modified. The 
SyberMate will provide an opportunity for the old file to be saved before the new 
file is created. 

Open When Open is selected, a screen pops up that allows the operator to select an 
existing file to be loaded into the translator. 

Save When Save is selected when working with an existing file, that file will be 
modified. When Save is selected when working with a new file, a popup menu will 
appear to enable the operator to select a new file name and indicate the drive 
where the file is to be stored. 
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Save As Pops up a screen where a new file name can be assigned and the file location 

can be assigned. 

Name and Font Pops up a screen where the character set can be selected for translated mes-
sages. 

 
 
 

 
 
Figure 26 
 
 
 

Retrieve from SyberTrol Retrieves the current set of literals from the SyberTrol to the translation clipboard 
in the SyberMate. 

Update SyberTrol Downloads the translated messages from the translation clipboard to the 
SyberTrol. 

Exit Exits the translator screen back to the main SyberMate screen. 
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Search Pops up a screen where a word or a string of text can be entered and located in 

the literals file. The search mechanism is case sensitive; therefore, the word or 
phrase must be entered exactly as it appears in the literals file. 

 
 
 

 
 
 
Figure 27 
 
 
 

Find Used to find the initial occurrence of the word or string. 

Find Next Used to fine the subsequent occurrences of a word or string. 

Close Closes the “Search” function and returns to the translator screen. 
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Using the Translation Editor 

For translations where the Latin character set is used, the SyberTrol literals can be changed by simply moving the 
cursor to the message that is to be translated and typing in the translation or new message. 

For translations where a new character set is required for the translation, the following procedure is used: 

1. From the File menu, choose “Name and Font.” The following screen will be displayed: 

 

 

Figure 28 
 
2. Select the arrow on the right side of the “Character Set” window. The current character sets that are resident 

in the SyberMate will be displayed. The current version of SyberMate contains the default Latin character set 
and the Cyrillic (PC-866) character set. 

3. Select the Cyrillic (PC-866) character set. Click on “OK.” Note that the font must be selected in the SyberMate 
program. 

 

 
 

Figure 29 
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4. Now that the SyberMate program has been set up for the Cyrillic (PC-866) character set, the Windows char-

acter mapping program must be activated on the computer. 
 

 

 
 

Figure 30 
 
 
 
5.  Double-click on the character map symbol. 
 
 

 
 

Figure 31 
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6. Position screens so that both the SyberMate translator display and the character map display are on the 

screen.  

 

 

Figure 32 
 
 
7. On the character map screen, double-click on the characters to make up the literal that is being translated. As 

each character is double-clicked, it will appear in the “Characters to Copy” window. 
 
 
 

 
 

Figure 33 
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When the translation has been completed, it can be copied to the SyberMate by selecting the “Copy” button on 
the character map or by highlighting the message and pressing “CTRL” and “C” simultaneously on the keyboard. 

8. Move the cursor to the field for the message or literal that is being translated and press “CTRL” and “V” simul-
taneously on the keyboard. The literal is now transferred to the SyberMate. 

 

 

Figure 34 
 

 

9. Continue until the entire list of literals have been translated. Caution: Translations should be restricted in 
length to no more than the number of characters that is in the default message to be sure the literals will be 
displayed correctly on the SyberTrol when downloaded. 

10. Once the translation has been completed, it should be saved in an xxxx.lng file in the SyberMate, then down-
loaded to the SyberTrol through the “Update SyberTrol” menu selection. 
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Equation Editor 

The equation editor is used to display the equations that have been set up in the SyberMate or that are being set 
up in the SyberMate. 

 

 

Figure 35 
 

From this screen, there are two menus available, “File” and “Edit.” There are also three buttons that are used for 
inserting new equations onto the screen, deleting equations from the screen, and modifying equations or state-
ments on the screen. The following actions are available from this screen. 

File Displays the following menu items: 

  New Equation Set Used to set up a file of new equations. 

  Open Equation Set Used to open an existing file of equations that has been saved on the system. 

     Save Equation Set Used to save the equations that are being edited in an existing file. 

  Save Equation Set As... Used to save the equations that are being edited in a new file. 

  Read Set from SyberTrol Used to read the equation set that is currently being used by the SyberTrol. 

  Download to SyberTrol... Downloads to the SyberTrol the equations that are being displayed. 
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  Print Equation Set Prints the equation set to the printer that is wired to the computer. 

     Exit Equation Editor Exits the equation editor screen and returns to the main SyberMate screen. 

Edit  

  Cut Cuts the highlighted equation from the screen and places it on the clipboard 
for placement by the Paste command. 

     Copy Copies the highlighted equation on the screen to the clipboard for placement 
by the Paste command. 

  Paste Pastes the information on the clipboard to the “Equation Editor” screen. 

     Insert Performs the same function as the Insert button on the right side of the 
screen. Selecting Insert will display the following screen: 

     Delete Deletes the selected item. 
 
 
 

 

Figure 36 
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This screen is used to define the equation(s) that will be displayed on the “Equation Editor” screen. 

Delete Performs the same function as the Delete button on the right side of the screen. Select-
ing “Delete” will remove the highlighted line from the screen. 

   Modify This button is used to display the “Edit Equation Line” screen for the equation that is 
highlights on the “Equation Editor” screen. (See Figure 37 above.) 

   Delete Performs the same function as described above on the “Edit” menu. 

   Insert Performs the same function as described above on the “Edit” menu. 

 

Equation Editor 

The “Equation Editor” screen is divided into two sections. One is the “High Speed” area, where only Boolean ex-
pressions are addressed. This area has a maximum of 50 lines available for Boolean expressions. These expres-
sions are evaluated once every 100 milliseconds. The other area is the “General Purpose” area, where a maxi-
mum of 150 lines of expressions can be developed. This is where algebraic expressions are developed. They are 
evaluated once every 500 milliseconds. 

Edit Equation Line 

The “Edit Equation Line” screen is the screen where the Boolean equations and algebraic expressions are devel-
oped. 

 

 

Figure 37 
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Data Element Set This window allows the user to select the element that will be set. In the case of the 

“Send” command, this window allows the user to designate which system or meter will 
be addressed. 
     *Temporary Boolean variable (1-99) 
     *User Boolean register (1-99) 
      Temporary float variable (1-99) 
      User float register (1-99) 
     *Digital I/O state (1-32) 
      Analog I/O state (1-12) 
     *Timer (1-16) 
     *“Send” command (0 Sys, 1-9 Mtr) 
Any of the above elements can be set using the algebraic equations. 
Those marked with an “*” can be set through the Boolean equations 

Offset The offset window is used to select the specific number of the variable, register, I/O 
number, timer, or “Send” command to be used. 

If Command The “If command” window data is used only if the “Send” command is present in the 
“Data Element Set” window. The “If” command selections are: 
     System: Set Prover Controller 
                   Prover ID Select 
                   Print System Report 
                   Print System User Report 
                   Set System Alarm 
                   Ack System Alarm 
                   Clear System Alarm 
     Meter:    Batch Control 
                   Sampler Control 
                   Print Meter Report 
                   Update Meter Factors 
                   Prover Control 
                   Print User Meter Report 
                   Set Meter Alarm 
                   Ack Meter Alarm 
                   Clear Meter Alarm 

 
 
“If” Command 
These commands are used to activate a command in the SyberTrol (i.e., in the “Starting a New Batch Based on 
Product Density Change” example, the meter 1 Batch command is used to end the existing batch and start a new 
batch. To use these commands, 

1. Choose “Send Command (0 Sys, 1-9 Mtr)” from “Data Element Set.” 

2. Choose the command that is to be issued in the “If Command” window. 

3. Add the remainder of the expression in the “New Value of Data Element” window (i.e., 0 IF USERBOOL5). 

4. Choose “OK” to load the expression into the editor. 
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New Value Data Element This is the area on the screen where data can be entered for developing the 

Boolean and algebraic equations. See the examples for the types of data that 
can be entered. 

Shortcut Keypad Can be used for entering data in the “New Value of Data Element” window. The 
keypad can be used for entering numerical data plus logical expressions. It also 
provides a button that will aid in finding the register number for elements in the 
database. 

Equivalent Description This is a Read Only window that displays a description of the expression being 
developed. If there is a problem with the expression, error messages will also be 
displayed in this window. 

Disabled If this box is checked, the expression will be disabled and not used. It can be en-
abled later via the SyberTrol 

OK If the expression developed meets the user’s approval, the “OK” button is 
pressed and the expression is moved to the “Equation Editor” screen. 

Cancel If the expression that has been developed is not satisfactory, it can be canceled. 
When the “Cancel” button is pressed, the program will return to the “Equation 
Editor” screen. 

 

Programmable and Boolean Statements 

A Boolean statement is a statement that has two states: “true” or “false.”  There are different ways to express 
each of these values: 

 TEMPBOOL1 = true   
 TEMPBOOL1 = on Equivalent statements  
 TEMPBOOL1 = 1   
    
 TEMPBOOL2 = false   
 TEMPBOOL2 = off Equivalent statements  
 TEMPBOOL2 = 0   
 

The logical operators that are used in conjunction with Boolean statements are “NOT”, “AND”, “OR”, and “XOR.” 

NOT A Boolean logic operator indicating negation. A variable designated with a “NOT” in 
front of it will be the opposite of its “AND” or “OR” function. It is a switching function 
for one variable. 

AND A Boolean logic operator similar to multiplication. If two variables are involved, both 
must be true for the output to be true. 

OR A Boolean logic operator similar to addition except that two truths add up to one 
truth. Using two variables, only one needs to be true for the output to be true. 

XOR A Boolean logic operator in which the output is true if either of two variables is true 
but not if both are true. 
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Boolean Logical Operation Tables 
 

A B AND OR XOR NOT A AND B 

0 0 0 0 0 1 

0 1 0 1 1 1 

1 0 0 1 1 1 

1 1 1 1 0 0 

 
Examples of the use of the above defined logical operators are as follows: The true or false at the right-hand side 
of the expression is the evaluation of that expression. 

Definition: TEMPBOOL1 = True 
 TEMPBOOL2 = True 
 TEMPBOOL3 = False 
 
NOT 
TEMPBOOL4 = NOT TEMPBOOL3 (True) 

AND 
TEMPBOOL5 = TEMPBOOL1 AND TEMPBOOL2 (True) 
TEMPBOOL6 = TEMPBOOL1 AND TEMPBOOL3 (False) 
 
OR 
TEMPBOOL7 = TEMPBOOL1 OR TEMPBOOL3 (True) 
 
XOR 
TEMPBOOL8 = TEMPBOOL1 XOR TEMPBOOL3 (True) 
TEMPBOOL9 = TEMPBOOL1 XOR TEMPBOOL2 (False) 
 
 
Specific Boolean Expressions 

When constructing a set of equations that take action based on a level value such as a temperature, a status 
value, the state of a digital I/O point, or any other value that may change between the evaluation of one equation 
and the next; read the value into a temporary or user-defined variable (Boolean or float, as applicable); and use 
the variable, not the actual value, in multiple equations. 

Boolean equations can be more clearly expressed as a result of an evaluated expression than by assigning a 
value conditionally. For example, let us assume that we want to turn on a digital output when the product tem-
perature of a specific meter is between 70  and 90 , inclusive, and turn the same digital output off again when the 
temperature is no longer within that range. Because of the left-to-right evaluation of Boolean and algebraic ex-
pressions, it is recommended that the expressions be broken down into simple expressions so that the results are 
as expected. 
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For this example, we will show three separate methods of writing the expressions that will accomplish the results 
that are expected. 

Example 
 TEMPBOOL1 = @5121901 > = 70 
 TEMPBOOL2 = @5121901 < = 90 
 TEMPBOOL3 = TEMPBOOL1 AND TEMPBOOL2 
 DIO1 = ON IF TEMPBOOL3 
 DIO1 = OFF IF NOT TEMPBOOL3 
 
 where @5121901 = the meter #1 current temperature register and 
 DIO1 = Digital Output #1. 
 
This set of equations will have the expected results, i.e., the digital output will be “ON” when the temperature is in 
range and “OFF” when the temperature is out of range. The same results can be achieved with the following set 
of expressions:  
 
 TEMPBOOL1 = @5121901 > = 70 
 TEMPBOOL2 = @5121901 < = 90 
 DIO1 = TEMPBOOL1 AND TEMPBOOL2 
 
where Digital Output #1 will be on if TEMPBOOL1 AND TEMPBOOL2 = True and off if they = False. 
 
With the above two examples, if the temperature changed from the evaluation of expression one to expression 
two, the expected result would not be correct. In order to overcome this possibility, another step can be added to 
the expression. 

 TEMPFLOAT1 = @5121901 
 TEMPBOOL1 = TEMPFLOAT1 > = 70 
 TEMPBOOL2 = TEMPFLOAT1 < = 90 
 DIO1 = TEMPBOOL1 AND TEMPBOOL2 

Example - Setting a Time 
The starting of a timer is not as straightforward as it might seem. For this example, we want to start timer #9 
which is a timer that increments in minutes if we use the Boolean equation 

TIMER9 = ON 

to turn the timer on. It will never increment above 1 because each time the expression is evaluated, it will get re-
set to “ON” and restart. We can add a conditional “IF” statement to get around this problem. The new expression 
would be 

TIMER9 = ON IF TIMER9 = 0. 
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The following example is used to determine the time that batches are being run on meter #1 in minutes, during a 
certain period of time (8 hours, 24 hours, etc.). This is determined by monitoring register 6120401 for an indica-
tion of when a batch is in progress for meter #1. 

 TEMPBOOL1 = @6120401 
 USERFLOAT1 = 1 IF USERFLOAT1 = 0 
 TIMER9 = USERFLOAT1 IF TEMPBOOL1 AND NOT TEMPBOOL2 
 TIMER9 = OFF IF TEMPBOOL2 AND NOT TEMPBOOL1 
 TEMPBOOL2 = TEMPBOOL1 
 USERFLOAT1 = TIMER9 IF TIMER9 > 0 

Explanation of the above Boolean expression: 

1. TEMPBOOL = @6120401 - This expression will be either true or false depending on the status of the regis-
ter. If the register indicates a batch in progress, it will be “true.” If no batch is in progress, it will be “false.” 

2. USERFLOAT1 = 1, IF USERFLOAT1 = 0 - This expression initializes the userfloat register to “true” if it was 
“false.” 

3. TIMER9 = USERFLOAT1 IF TEMPBOOL1 AND NOT TEMPBOOL2 - This expression turns the timer off if the 
TEMPBOOL2 register is “true” and the TEMPBOOL1 register is “false.” 

4. TIMER9 = OFF IF TEMPBOOL2 AND NOT TEMPBOOL1 - This expression turns the timer off if TEMP-
BOOL2 register is “true” and the TEMPBOOL1 register is “false.” 

5. TEMPBOOL2 = TEMPBOOL1 - This expression sets the TEMPBOOL2 register equal to the TEMPBOOL1 
register. 

6. USERFLOAT1 - TIMER9 IF TIMER9 > 0 - This expression sets the USERFLOAT1 register to the timer value 
if the timer value is greater than 0. This value will then be used as the starting value for the timer the next time 
a batch is started. 

Algebraic Expressions 

The SyberTrol converts all algebraic values to double precision floating point values prior to performing calcula-
tions. 

Calculations may be defined using positive or negative whole numbers, fractional numbers, or a combination. Al-
gebraic expressions are evaluated from left to right and all operators (+, -, /, *) have the same precedence. Multi-
plication does not take place before addition, etc. The following expression has a result of 54. 

TEMPFLOAT1 = 4 + 5 * 6 (Result 54, 4 + 5 = 9 * 6 = 54) 

Algebraic processing will allow out of range values, such as division by zero, or evaluations of expressions whose 
results are greater than the range of a double precision floating point variable. It is the responsibility of the user to 
ensure that valid expressions are used. 
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Example - Flow Rate Conversion 
This is a simple example for converting the flow rate that is currently being run through meter #1 from bar-
rels/hour to gallons/minute. The Meter #1 current flow rate register is 5120301. 

USERFLOAT1 = @ 5120301 * 42/60 

where USERFLOAT1 is the register where the results of the current flow rate (register 5120301) times 42 divided 
by 60 is stored. This value can then be accessed through communications, or used on the user configurable re-
ports and displays. 

Example - Temperature Conversion 

This example will convert the temperature that is being read by the SyberTrol for meter #1 from Fahrenheit to Cel-
sius. The current temperature register is 5121901. 

USERFLOAT2 = @ 5121901 - 32/1.8 

where USERFLOAT2 is the register where the results of the current temperature in degrees Fahrenheit (register 
5121901) minus 32 degrees divided by 1.8 are stored. This is the equivalent temperature in degrees Celsius, and 
can be accessed through communications or used on the user configurable reports and displays. 

Example - Starting a New Batch Based on Product Density Change 

This example will start a new batch of product 3 on meter #1 if the product density changes and stays in the new 
range for at least five seconds. The new range in this example is between 40 and 50 API. This example assumes 
that the batches have been preset in the SyberTrol and the first batch is running. 

1.  USERBOOL1 = TRUE IF @ 5122101 > 40 
2.  USERBOOL2 = TRUE IF @ 5122101 < 50 
3.  USERBOOL3 = TRUE IF USERBOOL1 AND USERBOOL2 
4.  TIMER5 = OFF IF NOT USERBOOL3 
5.  TIMER5 = ON IF USERBOOL3 AND NOT USERBOOL4 
6.  USERBOOL4 = TRUE IF TIMER5 > 0 
7.  USERBOOL5 = TRUE IF TIMER5 > 5 
8.  METER1 BATCH: 0 IF USERBOOL5 AND USERBOOL3 
9.  TIMER5 = OFF IF USERBOOL5 AND USERBOOL3 

 
where 

  Expressions 1 and 2 are tests for the product density. 

  Expression 3 is true if the density is within the range being tested for. 

  Expression 4 turns timer #5, a one-second timer, off if the product is not within the density range being tested 
for. 

  Expression 5 turns the timer on if the density is in the range and the timer is currently off. 

  Expression 6 is true if the timer is currently on. 
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  Expression 7 is true if the timer is on over five seconds. 

  Expression 8 ends the current batch and starts the next batch if the timer has been on for more than five sec-
onds and the density is in the range. 

  Expression 9 turns the timer off if it has been on for more than five seconds and the density is in the range. 
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